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Advance IPPTZ 

 

 

 

 

       

 

Veuillez lire intégralement ce manuel avant d’utiliser la caméra et conservez-le pour vous y 

référer ultérieurement. 
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Exclusion de responsabilité 

 Ce manuel est fourni uniquement comme référence pour l’utilisateur. 

 Ce manuel est disponible pour de nombreux modèles. Il se peut que certaines fonctions 

présentées dans ce manuel ne soient pas disponibles sur certains modèles. 

 Le contenu de ce manuel peut être modifié sans préavis. Les mises à jour seront ajoutées dans 

la nouvelle version du manuel. 

 Ce manuel peut contenir plusieurs passages techniquement incorrects ou contenir des erreurs 

d’impression. Si tel est le cas, n’hésitez pas à nous en faire part. Nous l’améliorerons 

immédiatement ou nous mettrons à jour les procédures décrites dans le manuel. 

 

Remarques relatives à la sécurité 

◼ Veuillez connecter l’appareil à l’alimentation électrique spécifiée. 

◼ N'essayez pas de démonter la caméra ; ne retirez pas les vis ni les couvercles afin d'éviter tout 

risque de choc électrique. 

◼ Il n'y a pas de pièces réparables par l'utilisateur à l'intérieur. Veuillez contacter dès que possible 

le centre de service le plus proche en cas de panne. 

◼ Évitez les utilisations incorrectes, les chocs et les vibrations, les pressions excessives 

susceptibles d’endommager le produit. 

◼ N'utilisez pas de détergent corrosif pour nettoyer le corps principal de l'appareil. Au besoin, 

veuillez utiliser un chiffon doux et sec pour éliminer la saleté ; pour les salissures tenaces, utilisez 

un détergent neutre. Tout nettoyant pour meubles de haute qualité peut convenir. 

◼ Évitez d’orienter la caméra directement vers des objets extrêmement lumineux, comme le soleil, 

car cela pourrait endommager le capteur d’image. 

◼ Veuillez suivre les instructions pour installer la caméra. Ne renversez pas la caméra. 

◼ Ne l’utilisez pas dans des conditions de température, d’humidité et d’alimentation électrique hors 

des limites stipulées. 

◼ Maintenez-la éloignée de sources de chaleur telles que radiateurs, bouches de chaleur, fours, 

etc. 

◼ N’exposez pas le produit au flux d’air provenant directement d’un climatiseur. Cela risquerait de 

provoquer une condensation d’humidité à l’intérieur de la bulle en raison de la différence de 

température entre l’intérieur et l’extérieur du dôme de la caméra. 
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1  Connexion au réseau 

Connectez la caméra IP (IPC) via LAN ou WAN par le biais du navigateur Internet Explorer. 

 

1.1  LAN 

En réseau local, il y a deux façons d'accéder à l’ICP : 1. via le logiciel Comelit Advance IP Tool ; 2. via le 

navigateur Internet Explorer. 

 

1.1.1 Accès via Comelit Advance IP Tool 

Connexion au réseau : 

 

 

 

① Assurez-vous que le PC et l’IPC sont connectés au réseau local (LAN) et que le Comelit Advance 

IP Tool est installé sur le PC. 

② Double-cliquez sur l’icône Comelit Advance IP Tool sur le bureau pour lancer ce logiciel comme 

illustré ci-dessous : 

 

 

 

③ Modifiez l’adresse IP. L’adresse IP par défaut de la caméra est 192.168.1.150. Cliquez sur les 

informations de la caméra figurant dans le tableau ci-dessus pour afficher les informations sur le 

réseau à droite. Modifiez l'adresse IP et la passerelle de la caméra et assurez-vous que son adresse 

réseau se trouve dans le même segment de réseau local que celui de l'ordinateur. 
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Par exemple, l'adresse IP de votre ordinateur est 192.168.1.4. Par conséquent, l'adresse IP de la 

caméra doit être remplacée par 192.168.1.X. Après la modification, entrez le mot de passe de 

l'administrateur et cliquez sur le bouton « Modify » (Modifier) pour modifier le paramètre. 

 

  
 

④ Double-cliquez sur l’adresse IP et le système affichera la fenêtre du navigateur IE pour connecter 

l’IPC. Suivez les instructions pour télécharger, installer et exécuter le contrôle ActiveX.  

 

 

 

Saisissez le nom d'utilisateur et le mot de passe dans la fenêtre de connexion. 

 

  
 
 

Le mot de passe par défaut de l’administrateur est admin. 

Le nom d'utilisateur par défaut est admin ; le mot de passe par 

défaut est admin. 
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Le système affiche le champ de saisie de texte ci-dessus pour vous demander de modifier le mot de 

passe par défaut. Il est vivement recommandé de modifier le mot de passe par défaut pour la sécurité 

du compte. Si la case « Do not show again » (Ne plus afficher) est cochée, le champ de saisie de texte 

n'apparaîtra pas la prochaine fois. 

 

1.1.2 Accès via Internet Explorer 

Les paramètres réseau par défaut sont les suivants : 

Adresse IP : 192.168.1,150 

Masque de sous-réseau : 255.255.255.0 

Passerelle : 192.168.1,1 

HTTP : 80 

Port de données : 9008 

 

Utilisez les paramètres par défaut ci-dessus lorsque vous vous connectez à la caméra pour la 

première fois. Raccordez la caméra à l'ordinateur directement via le câble réseau. 

 

 

 

① Définissez manuellement l’adresse PC, le segment réseau doit être le même que les réglages par 

défaut de la caméra IP. Ouvrez le réseau et le centre de partage. Cliquez sur « Local Area 

Connection » (Connexion au réseau local) pour faire apparaître la fenêtre suivante : 

 



 

4 

 

 

 

Sélectionnez « Properties » (Propriétés), puis le protocole Internet (par exemple : IPv4). Cliquez 

ensuite sur le bouton « Properties » (Propriétés) pour configurer le réseau du PC. 

 

 

② Ouvrez le navigateur Internet Explorer, saisissez l’adresse par défaut de l’IPC et confirmez. 
③ Suivez les instructions pour télécharger et installer le contrôle ActiveX. 

④ Entrez le nom d'utilisateur et le mot de passe par défaut dans la fenêtre de connexion, puis entrez 

dans Live view (Vue en direct). 

 

1.2  WAN 

➢ Accès via routeur ou serveur virtuel  
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①  Veillez à ce que la caméra soit connectée au réseau local, accédez ensuite à la caméra via LAN 

et allez au menu Config→Network (Réseau)→menu Port pour définir le numéro de port. 

 

 

Configuration du port      

 

② Allez à Config →Network (Réseau)→menu TCP/IP pour modifier l’adresse IP. 

 

 

Configuration IP 

 

③ Allez à l’interface de gestion du routeur via le navigateur Internet Explorer pour envoyer l’adresse IP 

et le port de la caméra au « Serveur virtuel ». 
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Configuration du routeur 

④ Ouvrez le navigateur IE et entrez son WAN IP et port http pour l’accès. (par exemple, si le port http 

est modifié et passe à 81, veuillez entrer “192.198.1.150:81” dans la barre d’adresse du navigateur 

internet pour l’accès). 

 

➢ Accès via le protocole PPPoE  

 

Connexion au réseau 

 

 

 

Accédez à la caméra via la connexion automatique PPPoE. Les étapes de la configuration sont les 

suivantes : 

① Allez au menu Config→Network (Réseau)→menu Port pour définir le numéro de port. 

② Allez à Config →Network (Réseau)→TCP/IP→menu Config PPPoE. Activez PPPoE et saisissez 

ensuite le nom d’utilisateur et le mot de passe de votre fournisseur de services internet. 

 

 

 

③ Allez au menu Config →Network (Réseau)→menu DDNS. Demandez un nom de domaine avant 

de configurer le DDNS. Veuillez consulter les instructions de configuration du DDNS pour plus de 

détails. 

④ Ouvrez le navigateur Internet Explorer et saisissez le nom de domaine et le port http pour l’accès. 

Accès via IP statique  
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Connexion au réseau 

 

 

 

Les étapes de réglage sont les suivantes : 

① Allez au menu Config→Network (Réseau)→menu Port pour définir le numéro de port. 

② Allez à Config →Network (Réseau)→menu TCP/IP pour définir l’adresse IP. Cochez « Use the 

following IP address » (Utiliser l’adresse IP suivante) et saisissez ensuite l’adresse IP statique et 

d’autres paramètres. 

③ Ouvrez le navigateur IE et saisissez son WAN IP et le port http pour l’accès.  
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2 Affichage Live 

La fenêtre suivante s’affiche après la connexion. 

  

 

Les descriptions de l’icône sur l’interface d’aperçu à distance sont les suivantes : 

 

Icône Description Icône Description 

 
Taille originale  

 
Indicateur d’enregistrement carte SD  

 
Ajuster l’échelle correcte  

 
Indicateur de couleur anormale  

 
Auto (remplir la fenêtre) 

 
Indicateur de clarté anormale  

 
Plein écran  

 
Indicateur de changement de scène  

 
Démarrage/arrêt de la vue en direct  

 
Indicateur de franchissement de ligne  

 
Démarrage/arrêt de l'audio bidirectionnel   Indicateur de densité de la foule  

 
Activer/désactiver audio  

 
Indicateur de comptage de personnes 

 
Instantané  

 
Indicateur de retrait d’objet  

 
Démarrage/arrêt enregistrement local  

 
Indicateur d’intrusion  

 
Zoom avant  

 
Indicateur d’intrusion de personnes 

 
Zoom arrière  

 
Indicateur d’alarme capteur  

 
Contrôle PTZ  

 
Indicateur d’alarme de mouvement  

 

Déplacez le curseur pour visualiser l'image en direct dans toutes les directions après que vous ayez 

cliqué sur ce bouton. En outre, tenez et faites glisser le bouton gauche de la souris pour zoomer dans 

l’image live. 
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Ces indicateurs d’alarme intelligents clignotent uniquement si la caméra prend en charge ces 

fonctions et si les événements correspondants sont activés. 

En mode plein écran, double-cliquez avec la souris pour quitter ou appuyez sur la touche ESC du 

clavier.  

 

Cliquez sur le bouton de commande PTZ pour déployer le panneau de commande. Dans l’interface 

d’aperçu à distance, vous pouvez visualiser l’image dans toutes les directions en utilisant le panneau 

PTZ. 

Les descriptions du panneau de commande sont les suivantes : 

 

 

Sélectionnez Preset (présélection) puis cliquez sur  pour l’activer. Sélectionnez et définissez la 

présélection puis cliquez sur  pour sauvegarder la position de la présélection. Sélectionnez la 

présélection définie puis cliquez sur  pour la supprimer. Sélectionnez Cruise (Tour) puis cliquez 

sur  pour commencer le tour. 

 

 

 

Icône Description Icône Description 

 

Cliquez pour faire tourner le 

dôme en diagonale vers le haut 

vers la gauche. 
 

Cliquez pour faire tourner le dôme 

en diagonale vers le haut vers la 

droite. 

 

Cliquez pour faire tourner le 

dôme vers le haut.  

Cliquez pour arrêter la rotation du 

dôme. 

 

Cliquez pour faire tourner le 

dôme vers la gauche.  

Cliquez pour faire tourner le dôme 

vers la droite. 

 

Cliquez pour faire tourner le 

dôme en diagonale vers le bas 

vers la gauche 
 

Cliquez pour faire tourner le dôme 

en diagonale vers le bas vers la 

droite. 

 

Cliquez pour faire tourner le 

dôme vers le bas. 
 

Faites glisser la barre de 

défilement pour ajuster la vitesse 

de rotation du dôme. 

 
Cliquez dessus pour faire un 

zoom arrière sur l'image live. 
 

Cliquez dessus pour faire un 

zoom avant sur l'image live. 

 Mise au point -  Mise au point + 

 Iris -  Iris + 

 Balayage Auto  Essuie-glace 

 Éclairage  Balayage aléatoire 

 Balayage de groupe  Présélection 

 Tour  Axe pass 
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3 Paramètres du menu 

Sur le panneau de commande PTZ de l’interface d’aperçu à distance d’Internet Explorer, appelez 

Preset 95 (Présélection 95) et cliquez sur . Vous verrez alors s’afficher les paramètres de menu 

suivants. 

 

 

 

 Les paramètres de menu peuvent être affichés lorsque la résolution de l’image live est 

définie à 1920×1080. 

 

Allez à l’interface du menu principal. Là vous pourrez sélectionner le menu en cliquant sur le bouton de 

direction.( ). 

 

 : pour se déplacer vers le haut et vers le bas dans le menu. 

 : pour retourner au menu. 

 : pour confirmer, pour entrer dans un sous-menu ou pour sélectionner le menu sur la droite. 

Remarque : un tiret (-) devant le menu signifie que ce menu n’est pas disponible. Des modèles 

différents peuvent avoir des menus différents. Les menus présentés dans ce manuel ne sont que des 

références. 

 

3.1 Informations de système 

Sélectionnez System Information (Informations système) en cliquant sur le bouton  ou , puis 

cliquez sur le bouton  pour entrer dans le menu tel qu’illustré ci-dessous : 

 

 

 

Vous pouvez y voir la version du logiciel et du micrologiciel, la caméra, la température du système, la 

date, l’identifiant du dôme, le protocole du dôme et le débit de transmission. 



 

11 

 

 

3.2 Paramétrage du Système 

Sélectionnez System Setup (Paramétrage du système) en cliquant sur le bouton  ou , puis 

cliquez sur le bouton  pour entrer dans le menu tel qu’illustré ci-dessous : 

 

   

 

3.2.1 Basculement automatique 

Sélectionnez Auto PT Flip (Basculement automatique) puis cliquez sur  pour configurer le menu 

sur la droite. Cliquez sur le bouton  ou  pour sélectionner ON/OFF (Activer/Désactiver). 

Cliquez ensuite sur le bouton  pour retourner au menu sur la gauche et cliquez sur le bouton  

pour sélectionner Exit (Quitter) ou Return (Retourner) (quitter la configuration ou retourner au menu 

principal). 

 

3.2.2 Paramétrage langue 

Anglais ou chinois. 

 

3.2.3 Paramétrage RS485 (non disponible pour certains modèles) 

Sélectionnez le menu de paramétrage RS485 comme illustré ci-dessous : 

 

 

 

Dome ID (identifiant du dôme) : de 001 à 255. 

Protocol (protocole) : PELCO-D ou PELCO-P. 

Baud Rate (débit de transmission) : de 1200 à 9600 bits/s. 
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3.2.4 Paramétrage Date/Heure 

Sélectionnez le menu de paramétrage de la date comme illustré ci-dessous : 

 

 

 

① Réglez la date et l’heure en cliquant sur les boutons fléchés. 

② Sélectionnez STORE (enregistrer) pour sauvegarder le réglage. 

 

3.2.5 Paramétrage du titre 

Sélectionnez le menu de paramétrage du titre comme illustré ci-dessous : 

 

 

 

Cliquez sur les boutons fléchés pour définir le titre puis enregistrez le réglage en sélectionnant STORE 

(enregistrer). 

 

3.2.6 Paramétrage du nord 

Sélectionnez NEXT (page suivante) puis le menu North Setup (Paramétrage du nord) comme illustré 

ci-dessous : 

 

 

 

① Choisissez un lieu en cliquant sur les boutons fléchés. 

② Sélectionnez STORE (enregistrer) pour sauvegarder le réglage. 

③ L’angle horizontal traitera la position du nord comme référence, sinon il traitera l’origine 

horizontale comme référence pour afficher l’angle de rotation de la caméra dans le sens horaire. 

④ Le PTZ vertical traitera son point le plus élevé comme référence (lorsque la caméra est parallèle 

au sol horizontal) pour indiquer l’angle entre la caméra et le sol horizontal. 
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3.2.7 Nouveau mot de passe et changement du mot de passe 

Sélectionnez le menu New Password (nouveau mot de passe) comme illustré ci-dessous : 

 

 

 

Entrez le mot de passe en cliquant sur le bouton  ou . 

 

➢ Les numéros de 0 à 9 sont disponibles. Le mot de passe doit être de 6 caractères. 

➢ Les mots de passe vides sont invalides lors de la définition du nouveau mot de passe. 

➢ Vous devrez entrer votre mot de passe lors de votre prochaine connexion. 

 

Sélectionnez le menu Change Password (changer mot de passe) comme illustré ci-dessous : 

 

 

 

➢ Saisissez le mot de passe actuel puis saisissez le nouveau mot de passe deux fois. 

➢ La saisie d’un nouveau mot de passe vide supprime le mot de passe en cours. 

 

3.2.8 Heure de sortie automatique 

Sélectionnez Auto Exit Time (Heure de sortie automatique) pour définir l’heure à laquelle vous quitterez 

automatiquement le menu. 

 

3.3  Confg caméra 

Sélectionnez Camera Setup (Paramétrage de la caméra) en cliquant sur le bouton  ou , puis 

cliquez sur le bouton  pour entrer dans le menu tel qu’illustré ci-dessous. 
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3.3.1 Commande caméra 

Sélectionnez le menu Camera Control  (Commande caméra) comme illustré ci-dessous : 

  

  

 

 

 

Brightness (luminosité) : permet de régler le niveau de luminosité de l’image.  

Sharpness (netteté) : permet de régler le niveau de netteté de l’image. 

Contrast (contraste) : permet de régler le contraste de l’image (non disponible sur certains modèles).  

Hue (teinte) : permet de régler la teinte de l’image (non disponible sur certains modèles).  

Antiflicker (anti-scintillement) (non disponible sur certains modèles) : 

⚫ OFF : désactive la fonction anti-scintillement. Cette fonction est utilisée principalement dans les 

installations extérieures. 

⚫ 50 Hz : réduit le scintillement dans des conditions d'éclairage de 50 Hz. 

⚫ 60 Hz : réduit le scintillement dans des conditions d'éclairage de 60 Hz.  

Paramétrage WDR : WDR permet de régler la caméra pour fournir une meilleure image lorsqu'il y a 

simultanément des zones très claires et très sombres dans le champ de vision.  
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Remarque : l'enregistrement s’arrêtera pendant quelques secondes lors du passage du mode 

non-WDR au mode WDR. 

HLC setup (paramétrage HLC) : si ON (activé), diminue la luminosité de l'image entière en supprimant 

la luminosité de la zone claire de l'image et en réduisant la taille de la zone du halo. 

⚫ HLC Level (Niveau HLC) : de 00 à 20. 

BLC : si cette fonction est activée (ON), l'exposition automatique s'active en fonction de la scène afin 

que l'objet de l'image dans la zone la plus sombre soit clairement visible. 

3D-NR : (Auto, Low (faible), Middle (moyen), High (élevé)). Permet de réduire le bruit de la luminosité 

et de la couleur de l’image dans les conditions de faible éclairage.  

Color Level (niveau de couleur) : permet d’ajuster la saturation de l’image (de 0 à 7). 

Defog Setup (paramétrage désembuage) : (Auto, Manuel). Activer cette fonction et définissez une 

valeur appropriée selon les besoins dans un environnement brumeux, poussiéreux, en présence de 

smog ou pluvieux pour obtenir des images claires. 

Gamma : mesure du contraste d’une image (non disponible sur certains modèles). 

VE : amélioration de la visibilité (non disponible sur certains modèles). 

High Sensitivity (haute sensibilité) : définissez comme il convient (non disponible sur certains modèles). 

 

3.3.2 Paramétrage Image 

Sélectionnez le menu Image Setup comme illustré ci-dessous : 

 

 

 

AE Setup (paramétrage AE) 

Sélectionnez le menu Image Setup (paramétrage Image) comme illustré ci-dessous : 

  

 

 

AE MODE (mode AE) : Auto, Bright (lumineux), Shutter (obturateur), IRIS ou Manual (manuel). 

Brightness (luminosité) : de 0 (le plus sombre) à 20 (le plus clair). Disponible uniquement lorsque le 

mode lumineux est sélectionné. 



 

16 

 

Shutter (obturateur) : plus la valeur est faible, plus l’image est claire. Disponible uniquement lorsque le 

mode obturateur ou manuel est sélectionné. 

IRIS : plus la valeur est élevée, plus la lumière entre. Disponible uniquement lorsque le mode IRIS ou 

manuel est sélectionné. 

Gain : définissez la valeur. Disponible uniquement lorsque le mode manuel est sélectionné. 

 

WB Setup (paramétrage balance des blancs) 

Sélectionnez le menu WB Setup (paramétrage WB) comme illustré ci-dessous : 

 

 

 

WB Mode : Mode équilibrage des blancs. Automatique ou manuel. 

MWB Red Gain : permet de définir la valeur de gain des rouges. Disponible uniquement lorsque le 

mode manuel est sélectionné. 

MWB Blue Gain : permet de définir la valeur de gain des bleus. Disponible uniquement lorsque le 

mode manuel est sélectionné. 

 

AGC 

Contrôle de gain automatique (Automatic Gain Control). De 0 à 15 

 

Inversement Image 

❖ MIRR : miroir. Tourne l’image horizontalement. 

❖ FLIP : tourne l’image verticalement. 

❖ ROTA : rotation. Tourne l’image horizontalement et verticalement. 

 

3.3.3 Paramétrage de l’objectif 

Sélectionnez le menu Lens Setup (paramétrage de l’objectif) comme illustré ci-dessous : 
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⚫ FOCUS LIMIT (limite mise au point) 

Définit la distance la plus courte de la mise au point. 

 

⚫ ZOOM MAG DISP (affichage agrandissement) 

Si cette option est ON (activée), vous verrez le facteur d’agrandissement du zoom sur l’image live. 

 

⚫ ZOOM SPEED (Vitesse de zoom) 

Permet de régler la vitesse du zoom. La plage est de 1 à 3 secondes. 

 

⚫ SCAN SPEED (Vitesse de balayage) 

Permet de régler la vitesse du balayage. La plage est de 1 à 20. 

         

⚫ DZOOM 

Mode zoom numérique (non disponible sur certains modèles). 

 

⚫ Len Initialize (initialiser l’objectif) 

Sélectionner cette option pour rétablir les valeurs d’usine par défaut. 

 

3.3.4 Paramétrage Jour et Nuit 

Sélectionnez le menu Day & Night Mode (mode jour & nuit) comme illustré ci-dessous : 

 

 

 

Auto : la caméra commute automatiquement entre mode jour et nuit en fonction de l’éclairage 

ambiant. 

Night (nuit) : la caméra restera en mode nuit (noir & blanc) en permanence. 

Day (jour) : la caméra restera en mode jour (couleur) en permanence. 

Time (heure) : la caméra basculera entre mode nuit et mode jour en fonction de l’heure jour et nuit 

définie. 

 

IR Sensitivity (Sensibilité IR) 

Permet de définir le niveau de la sensibilité IR (Low (faible), Middle (moyen), High (haut), Custom 

(personnalisé)).  
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3.3.5 Télécommande à infrarouge 

Auto, ON (activée) ou OFF (désactivée). 

 

3.3.6 Format Vidéo 

PAL ou NTSC. 

 

3.4  Fonction Dôme 

Sélectionnez le menu Dome Function (fonction dôme) comme illustré ci-dessous : 

 

  

 

3.4.1 Paramétrage présélection 

Cette fonction permet de mémoriser la position spécifique pan (panoramique), tilt (inclinaison), zoom et 

focus (mise au point) pour un retour rapide à cette position en appelant une présélection. 

① Sélectionnez le menu Select Preset (paramétrage présélection) tel qu’illustré ci-dessous. 

 

 

 

② Sélectionnez le PRESET NO: (numéro de présélection). 

③ Sélectionnez le menu EDIT CUR PRESET (modifier présélection en cours) comme illustré 

ci-dessous : 
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④ Press Iris- to switch menu mode and PTZ mode (Appuyez sur Iris- pour passer du mode menu 

au mode PTZ), et inversement. Sélectionner la position pré-sélectionnée en cliquant sur les 

boutons fléchés. 

⑤ Définissez le titre en cliquant sur le bouton  ou . 

⑥ Enregistrez le réglage. 

 

3.4.2 Configuration Cruise (Tour) 

Sélectionnez le menu de paramétrage Cruise (tour) comme illustré ci-dessous : 

 

 

 

L’enregistrement des présélections dans une liste Cruise (tour) permet ensuite au système de les 

rappeler en séquence à l’heure définie quand il exécute l’instruction Cruise (tour). 

① Sélectionnez le numéro Cruise (tour).Sélectionnez le PRESET NO: (numéro de présélection). 

② Sélectionnez le menu EDIT CUR CRUISE (modifier tour en cours) comme illustré ci-dessous. 

Cette caméra prend en charge 8 tours avec 16 présélections pour chaque tour. 

 

 

 

Sélectionnez le numéro de présélection (de 1 à 360) et le temps de pause (de 5 à 240 secondes). 

 

③ RUN CUR CRUISE (exécuter tour en cours). La caméra commencera automatiquement le tour. 

④ Sélectionnez STORE (enregistrer) pour sauvegarder le réglage. 

 

3.4.3 Configuration de groupe 

Sélectionnez le menu de paramétrage Grouping (regroupement) comme illustré ci-dessous : 
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Sélectionnez le menu EDIT GROUP (modifier groupe) comme illustré ci-dessous : 

 

 

 

8 tours peuvent être définis en un groupe. CRU 1 signifie Tour 1, CRU 2 signifie Tour 2 et ainsi de suite. 

RUN GROUP signifie exécuter les tours dans l’ordre. 

  

3.4.4 Configuration de tâche 

Sélectionnez le menu Task Setup (Configuration de tâche) comme illustré ci-dessous : 

 

 

 

En divisant 24 heures en plusieurs périodes et en attribuant différentes instructions à chaque période, 

le système de caméra exécutera automatiquement les instructions selon l’heure définie s’il n’y a 

aucune autre opération en cours. 

 

① Activez la tâche. 

② Définissez la tâche.  
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Time Format (format heure) : Start Time - End Time (heure de début - heure de fin). Les tâches seront 

exécutes automatiquement par ordre chronologique. 

Type de tâche : NON (aucune), RSC (balayage aléatoire), ASC (balayage automatique), PRE 

(présélection), CRU (tour), TRA (axe). 

 

  
 

 

3.4.5 Paramétrage d’axe (patrouille) 

Sélectionnez le menu Track Setup (Configuration d’axe) comme illustré ci-dessous : 

 

 

 

Cette fonction permet de mémoriser l’opération de pan (panoramique), tilt (inclinaison), zoom et focus 

(mise au point) à répéter en exécutant l’axe. 

① Choisissez le numéro d’axe. 

② Sélectionnez le menu Track Setting (définition d’axe). Cliquez sur « Iris– » pour lancer 

l’enregistrement de l’axe (180 secondes maxi.). Contrôlez le mouvement du dôme à l’aide des 

boutons fléchés puis enregistrez le réglage. Si la durée dépasse 180 secondes, le système 

enregistrera automatiquement les données de l’opération et retournera au menu précédent. En 

outre, 360 instructions peuvent être enregistrées pour chaque axe. Si le nombre de 360 

instructions est dépassé, le système enregistrera automatiquement les 360 premières 

instructions et retournera au menu précédent. 

③ Sélectionnez « RUN CUR TRACK… » (exécuter axe en cours) pour exécuter l’instruction. 

 

3.4.6 Alarm Setup (Config alarme) (non disponible pour certains modèles) 

Sélectionnez le menu Alarm Setup (Configuration d’alarme) comme illustré ci-dessous : 

Remarque : La fonction position accueil sera désactivée si la définition de 

tâche est activée. 
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① Sélectionnez ALARM IN NO (numéro entrée alarme). 

② Sélectionnez le menu EDIT CUR ALARM IN (modifier entrée alarme en cours) comme illustré 

ci-dessous : 

 

 

 

ALARM IN CON (condition entrée alarme) : Normally Open (NO, normalement ouvert)/Normally Close 

(NC, normalement fermé). 

ALARM IN MODE (mode entrée alarme) : ON (activé), OFF (désactivé) ou Time (heure). 

ALARM CALL (alarme appel) : appeler Preset (présélection)/Cruise (tour)/Track (axe)/Scan 

(balayage). Lorsque l’entrée d’alarme se produira, la caméra démarrera automatiquement la fonction 

définie. 

ALARM OVER (alarme terminée) : appeler Preset (présélection)/Cruise (tour)/Track (axe)/Scan 

(balayage). Lorsque le déclenchement de l’alarme s’arrêtera, la caméra démarrera automatiquement 

la fonction définie. 

OUTPUT ENABLE (activer sortie) : si cette option est sur ON (activée), lorsque l’entrée d’alarme se 

produira, la caméra générera des informations d’alarme. 

 

  
 

3.4.7 Position Accueil 

Sélectionnez le menu Home Position (position accueil) comme illustré ci-dessous : 

 

 

 

① Activez la fonction HOME (accueil) (ON) et sélectionnez la présélection (dans HOME SET 

[Accueil défini]). 

② Sélectionnez le délai (de 7 à 180 secondes) et quittez le menu. 

Remarque : Si le dôme est activé, l’alarme ne peut exécuter aucune 

instruction. 
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Lorsque le temps de pause dépasse le délai, la caméra exécute automatiquement la présélection 

définie. 

  

3.4.8  Paramétrage Essuie-glace (non disponible sur certains modèles) 

Sélectionnez le menu Wiper (essuie-glace) comme illustré ci-dessous : 

 

 

 

① Définissez la vitesse et la durée d’exécution. 

② Appelez « START » (démarrer) pour activer la fonction essuie-glace. 

 

3.5  Param. écran 

Vous pouvez activer l’affichage d’un titre et l’affichage de l’heure. 

 

 

 

3.6  Chargement des valeurs par défaut 

Il y a trois menus : master reset, master clear et master reboot. 

Master Reset (réinitialiser master) : restaure les réglages d’usine par défaut de la caméra, mais 

n’efface pas les paramètres tels que Preset (présélection), Cruise (tour). 

Master Clear (effacer master) : restaure les réglages d’usine par défaut de la caméra. 

System Reboot (redémarrer système) : redémarre la caméra.
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4  Configuration de la caméra réseau 

Dans le client Webcast, choisissez « Config » pour accéder à l'interface de configuration.  

Remarque : chaque fois que la situation le recommande, cliquez sur le bouton « Save » (Enregistrer) 

pour sauvegarder les paramètres. 

 

4.1 Configuration du système 

4.1.1 Informations de base 

Dans l’interface Basic Information (informations de base), vous pouvez vérifier les informations 

relatives du dispositif. 

 

 

 

Certaines versions peuvent prendre en charge l'ID de l'appareil et le code QR. Si P2P est activé (voir 

Configuration réseau-P2P), la caméra réseau peut être rapidement ajoutée au client de surveillance 

mobile, en scannant le code QR ou en entrant l'ID de l’appareil. 

 

4.1.2 Configuration de la date et de l’heure 

Allez à Config→System (Système)→Date and Time (Date et heure). Veuillez vous référer à l'interface 

suivante. 

 

 

 

Sélectionnez le fuseau horaire et l'heure d'été (DST) selon les nécessités.  

Cliquez sur l'onglet « Date and time » (Date et heure) pour définir le format horaire. 
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4.1.3 Configuration locale 

Allez à Config→System (Système)→Local Config (Config Locale)  pour configurer le chemin de 

stockage des images capturées et des vidéos enregistrées sur PC local. Il existe également une option 

permettant d'activer ou de désactiver l'affichage du débit binaire dans les fichiers enregistrés. 

 

 

 

4.1.4 Stockage 

Allez à Config→System (Système)→Storage (Stockage) pour accéder à l’interface comme illustré 

ci-dessous. 

 

 

 

⚫ Gestion de la carte Micro-SD 

Cliquez sur le bouton « Format » (Formater) pour formater la carte micro-SD. Toutes les données 

seront effacées en cliquant sur ce bouton. 

Cliquez sur le bouton « Eject » (Éjecter) pour arrêter l'écriture des données sur carte micro-SD. La 

carte micro-SD peut être ensuite retirée en toute sécurité. 

Quota d'instantanés : permet de définir la capacité des images capturées sur carte micro-SD. 

Quota de vidéos : permet de définir la capacité des fichiers d'enregistrement sur carte micro-SD. 
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⚫ Paramètres de programmation de l'enregistrement 

1.  Allez à Config→System (Système)→Storage (Stockage)→Record (Enregistrement) pour accéder 

à l’interface comme illustré ci-dessous.  

 

 

 

2.  Régler le flux d'enregistrement, le temps de pré-enregistrement, l'écriture du cycle. 

Pre Record Time: (Temps de pré-enregistrement) : permet de définir le temps d'enregistrement avant 

que l'enregistrement ne commence réellement. 

 

3. Définissez l'enregistrement programmé. Cochez « Enable Schedule Record » (Activer 

l'enregistrement programmé) et définissez l'horaire. 

 

 

 

Programmation hebdomadaire 

Réglez le temps d'enregistrement de l'alarme du lundi au dimanche pour une semaine. Chaque jour 

est divisé en une heure. Vert correspond à programmé. Blanc correspond à non programmé.  

« Add » (Ajouter) : ajoutez la programmation pour un jour précis. Faites glisser la souris pour régler 

l’heure le temps sur le calendrier. 

« Erase » (Effacer) : supprimer la programmation. Faites glisser la souris pour supprimer l’heure sur le 

calendrier. 

Saisie manuelle : cliquez sur un jour spécifique pour saisir une heure de début et de fin précis. 
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Programmation d’un jour 

Réglez l'heure de l'alarme pour un jour spécial, par exemple un jour de vacances. 

Remarque : La programmation des vacances est prioritaire sur celle hebdomadaire. 

 

⚫ Paramètres des instantanés 

Allez à Config→System (Système)→Storage (Stockage)→Snapshot (Instantané) pour accéder à 

l’interface comme illustré ci-dessous.  

 

 

 

Définissez ici le format, la résolution et la qualité de l'image enregistrés sur carte micro-SD, l'intervalle 

et la quantité d'instantanés et l'instantané du timing. 

Quantité d’instantanés : c'est la quantité maximale d’instantanés. La quantité réelle d’instantanés 

peut être inférieure à ce nombre. En supposant que le temps d'occurrence d'un événement d'alarme 

soit inférieur au temps de capture des images, la quantité réelle d’instantanés est inférieure à la 

quantité d’instantanés définie. 

 

Activer l'instantané de timing : activez d'abord l'instantané de timing, puis définissez l'intervalle et la 

programmation des instantanés. Les étapes de configuration de la programmation sont les mêmes 

que pour l'enregistrement de la programmation. 

 

4.2  Configuration des images 

4.2.1 Configuration vidéo / audio 

Aller à Image →interface Vidéo/Audio comme illustré ci-dessous. Dans cette interface, définissez la 

résolution, la fréquence d'images, le type de débit binaire, la qualité vidéo, etc. 
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Cliquez sur l'onglet « Audio » pour accéder à l'interface comme illustré ci-dessous. 

 

 

 

Trois flux vidéo peuvent être réglés. 

Résolution : résolution de l'image. 

Fréquence d'image : plus la fréquence d'image est élevée, plus la vidéo est fluide.  

Type de débit binaire : CBR ou VBR. Le débit binaire est lié à la qualité de l'image. CBR signifie que le 

débit binaire est maintenu constant, quel que soit le changement observé dans la scène vidéo. VBR 

signifie que le débit binaire est ajusté en fonction des changements de scène. 

Débit binaire : il peut être ajusté lorsque le mode est réglé sur CBR. Plus le débit binaire est élevé, 

meilleure sera la qualité de l'image. 

Qualité vidéo : elle peut être ajustée lorsque le mode est réglé sur VBR. Plus la qualité de l'image est 

élevée, plus de débit binaire sera nécessaire. 

I Intervalle d'images : il détermine combien d'images sont autorisées entre un « groupe d'images ». 

Lorsqu'une nouvelle scène commence dans une vidéo, jusqu'à ce que cette scène se termine, le 

groupe entier de cadres (ou d’images) peut être considéré comme un groupe d'images. S'il n'y a pas 

beaucoup de mouvement dans la scène, le réglage d'une valeur supérieure à la fréquence d'images 

suffit, ce qui peut entraîner une utilisation moindre de la bande passante. Cependant, si la valeur est 

trop élevée et qu'il y a une fréquence de mouvement élevée dans la vidéo, il y a un risque de saut 

d'image. 

Compression vidéo : H264 ou H265. Si vous choisissez H.265, assurez-vous que le système client 

est capable de décoder H.265. 

Profil : pour H.264, les profils Baseline, Main et High sont sélectionnables. 

Envoyer instantané : définit le nombre d'instantanés à générer pour un événement. 

Séparation de tranches d’encodage vidéo : si cette fonction est activée, il est possible d'obtenir une 

image lisse même en utilisant un PC à faible performance. 

Filigrane : lors de la lecture de la vidéo locale enregistrée dans l'interface de recherche, le filigrane 

peut être affiché. Pour l'activer, cochez la case du filigrane et entrez le texte du filigrane. 

Encodage audio : G711A ou G711U. 

Type d'audio : LIN ou MIC. 
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4.2.2 Configuration OSD 

Allez à Image→interface OSD comme illustré ci-dessous. 

 

 

 

Définissez ici l'horodatage, le nom de l'appareil, le contenu OSD et le chevauchement des images. 

Après l'activation, entrez le contenu et faites-les glisser pour modifier sa position. Cliquez ensuite sur le 

bouton « Save » (Enregistrer) pour sauvegarder les paramètres. 

 

 

 

Paramètres de chevauchement d'images (certains modèles seulement) : 

Cochez « OSD Content1 » (Contenu1), choisissez « Picture Overlay » (Superposition d'images) et 

cliquez sur « Browse » (Parcourir) pour sélectionner l'image de chevauchement. Cliquez ensuite sur 

« Upload » (Télécharger) pour télécharger l’image de chevauchement. La taille de l'image ne doit pas 

dépasser 200x200 pixels, sinon elle ne peut pas être téléchargée. 

 

4.2.3 Masque vidéo (Confidentialité) 

Allez à Image→interface Masque Vidéo comme illustré ci-dessus. Un maximum de 4 zones peut être 

configuré. 

Pour configurer le masque vidéo : 

1. Activez le masque vidéo. 

2. Cliquez sur les boutons de direction pour modifier la zone que vous souhaitez masquer. 

3. Cliquez sur le bouton « Draw area » (Tracer zone), puis faites glisser la souris pour tracer la zone du 

masque vidéo. 

4. Cliquez sur « Add » (ajouter) pour ajouter la zone d masque. 
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Pour effacer la zone du masque : 

1. Sélectionnez la zone de masque dans la liste des zones de masque. 

2. Cliquez sur Clear (supprimer) pour supprimer cette zone de masque. 

 

4.2.4 Confg caméra 

Allez à Config→Image→Camera Setup (configurer caméra). 

 

 

 

De nombreux paramètres de la caméra peuvent être définis dans le sous-menu ci-dessus, tels que 

Color (couleur), Brightness (luminosité), Sharpness (netteté), 3D DNR, Fog (brouillard), Day Night 

Mode (mode jour nuit), etc. 

Programmer les réglages des paramètres de l'image. 
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Cliquez sur l'onglet « Schedule » (Programmer) comme illustré ci-dessous. 
 

 
 

Définissez la programmation à temps plein pour le mode courant, jour, nuit et la programmation 

spécifique pour le mode jour et nuit. Choisissez « Schedule » (Programmer) dans le menu déroulant 

comme illustré ci-dessous. 
 

 
 

Faites glisser les icônes «  » pour régler l'heure du jour et de la nuit. Bleu correspond à jour et blanc à 

nuit. Si le mode actuel des paramètres de la caméra est réglé sur programmation, le mode de 

configuration de l'image bascule automatiquement entre le jour et la nuit en fonction de la 

programmation. 

 

4.3  Configuration PTZ 

4.3.1 Réglage PTZ et mot de passe 

⚫  Réglage PTZ 

Allez à Config→PTZ→Setting (Réglage). 

 

  

 

Dans ce sous-menu, vous pouvez définir le basculement PTZ automatique, la langue, l’heure de 

déconnexion automatique. 

Si votre modèle de caméra prend en charge l’interface RS485, vous pouvez configurer le réglage de 

communication pour la commande par clavier. 

 

⚫  Définition du mot de passe 

Si le mot de passe est défini, vous devez entrer le mot de passe à chaque fois que vous accédez au 

menu du PTZ en appelant la présélection N° 95. Allez à Config→PTZ→Setting (Réglage)→Others 

(autres). Vous pouvez définir le mot de passe du menu PTZ. 
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4.3.2 Restore (Rétablir) 

Il inclut la fonction de Reset (Réinitialiser) et Clear (Effacer). 

 

4.3.3 Fonction PTZ 

La fonction PTZ comprend comprend paramétrage de présélection, paramétrage de tour, paramétrage 

de groupe, paramétrage d’axe, paramétrage de tâche, paramétrage d’alarme, paramétrage de 

position accueil et paramétrage d’essuie-glace. 

 

4.4  Alarm configuration (configuration alarme) 

4.4.1 Détection de mouvement 

Allez à Alarme→Détection de mouvement pour définir l’alarme de détection de mouvement. 

 

 

 

1. Cochez la case « Enable » (Activer) pour activer les alarmes basées sur le mouvement. 

Sortie d’alarme : si cette fonction est sélectionnée, elle déclenche une sortie de relais externe 

connectée à la caméra lors de la détection d'une alarme de détection de mouvement. 

Déclencher instantané : si cette fonction est sélectionnée, le système capture des images lors de la 

détection de mouvement et les enregistre sur carte micro-SD. 
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Déclencher enregistrement SD : si cette fonction est sélectionnée, la vidéo est enregistrée sur carte 

micro-SD lors de la détection de mouvement.  

Déclencher e-mail : si « Trigger Email » (déclencher e-mail) et « Attach Picture » (Joindre image) sont 

cochés (l'adresse e-mail doit être définie au préalable dans l'interface de configuration de l'e-mail), les 

images capturées et l'événement déclenché sont transmis par e-mail. 

Déclencher FTP : si « Trigger FTP » (déclencher FTP) et « Attach Picture » (Joindre image) sont 

cochés, les images capturées sont envoyées à l'adresse du serveur FTP. Veuillez vous reporter au 

chapitre sur la configuration FTP pour plus de détails. 

 

2. Définissez la zone de détection de mouvement et la sensibilité. Cliquez sur l'onglet « Area and 

Sensitivity » (Zone et sensibilité) pour accéder à l'interface comme illustré ci-dessous.  

 

 

 

Déplacez la barre de défilement "Sensitivity" (Sensibilité) pour définir la sensibilité. Une valeur de 

sensibilité plus élevée signifie que l'alarme de mouvement se déclenchera plus facilement. 

Sélectionnez « Add » (Ajouter) et cliquez sur « Draw Area » (Tracer zone). Faites glisser la souris pour 

tracer la zone de détection de mouvement ; sélectionnez « Erase » (Effacer) et faites glisser la souris 

pour effacer la zone de détection de mouvement. 

Ensuite, cliquez sur le bouton « Save » (Enregistrer) pour sauvegarder les paramètres. 

 

3. Configurez « Schedule » (Programmation) pour la détection de mouvement. Les étapes de 

configuration de la programmation de la détection de mouvement sont les mêmes que celles pour la 

configuration de l'enregistrement de la programmation. 

 

4.4.2 Autres alarmes 

⚫ Carte Micro-SD pleine 

1. Allez à Config→Alarm (Alarme)→Anomaly (Anomalie)→SD Card Full (Carte SD pleine). 
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2. Cliquez sur « Enable » (Activer) et réglez la durée de maintien de l'alarme. 

3. Définissez les options de déclenchement de l'alarme. Les étapes de configuration sont les mêmes 

que celles pour la détection de mouvement. Veuillez consulter le chapitre sur la détection de 

mouvement pour plus de détails. 

 

⚫  Erreur de la carte Micro-SD 

En cas d'erreurs d'écriture sur la carte micro-SD, les alarmes correspondantes se déclenchent.  

1. Allez à Config→Alarm (Alarme)→Anomaly (Anomalie)→SD Card Error (Erreur carte SD) comme 

illustré ci-dessous. 

 

 

 

2. Cliquez sur « Enable alarm » (Activer alarme) et réglez la durée de maintien de l'alarme. 

3. Définissez les options de déclenchement de l'alarme. Déclenchez sortie d’alarme, e-mail et FTP. Les 

étapes de configuration sont les mêmes que celles pour la détection de mouvement. Veuillez consulter 

le chapitre sur la détection de mouvement pour plus de détails. 

 

⚫  Conflit adresse IP 

Cette fonction n'est disponible que sur certains modèles. 

1. Allez à Config→Alarm (Alarme)→Anomaly (Anomalie) →IP Address Collision (Collision adresse IP) 

comme illustré ci-dessous. 
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2. Cliquez sur « Enable » (Activer) et réglez la durée de maintien de l'alarme. 

3. Déclenchez sortie d’alarme. Lorsque l'adresse IP de la caméra est en conflit avec l'adresse IP 

d'autres appareils, le système déclenche la sortie d’alarme. 

 

⚫  Câble déconnecté 

Cette fonction n'est disponible que sur certains modèles. 

1. Allez à Config→Alarm (Alarme)→Anomaly (Anomalie)→Cable disconnected (Câble déconnecté) 

comme illustré ci-dessous. 

 

 

 

2. Cliquez sur « Enable alarm » (Activer alarme) et réglez la durée de maintien de l'alarme. 

3. Déclenchez sortie d’alarme. Lorsque la caméra est déconnectée, le système déclenche la sortie 

d'alarme. 

 

4.4.3 Entrée alarme  

Cette fonction n'est disponible que pour certains modèles. 

Pour régler l'alarme du capteur (Alarm In) (Entrée d’alarme) : allez à Config→Alarm 

(Alarme)→interface Alarm In (entrée d’alarme) comme illustré ci-dessous. 
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1. Cliquez sur « Enable » (Activer) et définissez le type d'alarme, la durée de maintien de l'alarme et le 

nom du capteur. 

2. Définissez les options de déclenchement de l'alarme. Les étapes de configuration sont les mêmes 

que celles pour la détection de mouvement. Veuillez consulter le chapitre sur la détection de 

mouvement pour plus de détails. 

3. Cliquez sur le bouton « Save » (Enregistrer) pour sauvegarder les paramètres. 

4. Définissez la programmation de l'alarme du capteur. Les étapes de configuration de la 

programmation sont les mêmes que celles pour l'enregistrement de la programmation. 

 

4.4.4 Sortie d’alarme 

Cette fonction n'est disponible que pour certains modèles. 

Allez à Config→Alarm (Alarme)→ Alarm Out (sortie d'alarme). 

 

 

 

Mode sortie d’alarme : Liaison d'alarme, fonctionnement manuel, lien de commutation jour/nuit ou 

timing. 
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Liaison d’alarme : après avoir sélectionné ce mode, définissez le nom de la sortie d'alarme, la durée 

de maintien de l'alarme dans la liste déroulante « Alarm Holding Time » (Durée de maintien de l'alarme) 

et le type d'alarme. 

Fonctionnement manuel : après avoir sélectionné ce mode, définissez le type d'alarme et cliquez sur 

« Open » (Ouvrir) pour déclencher l'alarme immédiatement. Cliquez sur « Close » (Clore) pour arrêter 

la sortie d'alarme. 
 

 

 

Liaison du commutateur jour/nuit : après avoir sélectionné ce mode, définissez le Type d'alarme, 

puis choisissez d'ouvrir ou de clore la sortie d'alarme lorsque la caméra passe en mode jour ou en 

mode nuit. 
 

 

 

Timing : sélectionnez le type d'alarme. Sélectionnez « Add » (Ajouter) et faites glisser la souris sur le 

calendrier pour définir la programmation de sortie des alarmes. Sélectionnez « Erase » (Effacer) et 

faites glisser la souris sur le calendrier pour supprimer la programmation définie. Après la sauvegarde 

de la programmation, la sortie d'alarme se déclenche dans le temps spécifié. 
 

 
 

4.4.5 Serveur alarme 

Allez à Alarm→interface Alarm Server (serveur alarme) comme illustré ci-dessous. 

Définissez l'adresse du serveur, le port, le battement de cœur et l'intervalle de battement de cœur. 

Lorsqu'une alarme se produit, la caméra transfère l'événement d'alarme au serveur d'alarme. Si un 

serveur d’alarmes n’est pas nécessaire, il n’est pas nécessaire de configurer cette section. 
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4.5  Configuration d’événements 

Cette fonction n'est disponible que pour certains modèles. 

Pour plus de précision, voici quelques recommandations d'installation. 

⚫ La caméra doit être installée sur une surface stable, car les vibrations peuvent affecter la 

précision de la détection. 

⚫ Évitez de pointer l'appareil photo vers des surfaces réfléchissantes (comme les sols brillants, les 

miroirs, le verre, la surface d’un lac, etc.). 

⚫ Évitez les endroits étroits ou avec trop d'ombres. 

⚫ Évitez les lieux où la couleur de l'objet est similaire à la couleur de l'arrière-plan.  

⚫ À tout moment du jour ou de la nuit, assurez-vous que l'image de la caméra est claire et avec 

une lumière adéquate, en évitant une surexposition ou une trop grande obscurité des deux 

côtés. 

Remarque ! les fonctions suivantes ne sont disponible que lorsque le « speed dome » cesse 

de tourner. 

 

4.5.1 Retrait d’objet 

Des alarmes seront déclenchées lorsque les objets seront retirés de ou abandonnés dans le secteur 

prédéfini.  

Pour définir le retrait d’objet : 

Allez à Config→Event (Événement)→Object Removal interface (Interface de retrait d’objet) comme 

illustré ci-dessous. 
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1. Activez la détection de retrait d’objet puis sélectionnez le type de détection. 

Enable Left Detection (activer détection objets abandonnés) : une alarme sera déclenchée si des 

objets sont abandonnées dans le secteur prédéfini. 

Enable Item Missing Detection (activer détection objets manquants) : une alarme sera déclenchée si 

des objets sont manquants dans le secteur prédéfini. 

2. Réglez la durée de maintien de l'alarme et les options de déclenchement de l'alarme. Les étapes de 

configuration sont les mêmes que celles pour la détection de mouvement. 

3. Cliquez sur le bouton « Save » (Enregistrer) pour sauvegarder les réglages. 

4. Définissez la zone d’alarme de la détection de retrait d’objet. Cliquez sur l'onglet « Area » (Zone) 

pour accéder à l'interface comme illustré ci-dessous. 
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Définissez le numéro de zone d’alarme, puis saisissez le nom de la zone d’alarme souhaitée. Il est 

possible d'ajouter jusqu'à 4 zones d'alarme. Cliquez sur le bouton « Draw Area » (Tracer zone) puis 

sélectionnez la zone que vous souhaitez définir comme zone d'alarme dans l'image de gauche (la 

zone d'alarme doit être une zone fermée). Cliquez sur le bouton « Stop drawing » (Arrêter de tracer) 

pour arrêter le traçage. Cliquez sur le bouton « Clear » (Effacer) pour supprimer la zone d'alarme. 

Cliquez sur le bouton « Save » (Enregistrer) pour sauvegarder les réglages.  

5. Définissez la programmation de la détection de retrait d’objet. Les étapes de configuration de la 

programmation sont les mêmes que celles pour l'enregistrement de la programmation. 

 

※ Configuration de la caméra et de la zone environnante 

1. Les objets détectés ne doivent pas être inférieurs à 1/50 jusqu’à 1/3 de l’image entière. 

2. Assurez-vous que les caméras puissent visualiser les objets pendant au moins de 3 à 5 secondes. 

3. La zone définie ne peut être couverte fréquemment et en continu (personnes et trafic). 

4. Le cadre du tracé doit être proche de la marge de l’objet afin de renforcer la sensibilité et la précision 

de la détection. 

5. Détection de retrait d’objet non activée avec scènes de divers changements de luminosité. 

6. Détection de retrait d’objet non activée s’il y a des environnements complexes et dynamiques dans 

la scène. 

8. Un éclairage adéquat et un contexte éclairé sont essentiels à la détection de retrait d’objet. 

 

4.5.2 Exception 

Cette fonction peut détecter les changements intervenant dans l'environnement de surveillance affecté 

par des facteurs externes.  

Pour définir la détection d’exceptions : 

Allez à Config→Event (Événement)→interface Exception, comme illustré ci-dessous. 
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1. Activer la détection souhaitée. 

Détection de changement de scène : l'alarme se déclenche si la scène change.  

Détection de flou vidéo : l'alarme se déclenche si la vidéo devient floue.  

Activer la détection de la couleur de la vidéo : l'alarme se déclenche si la vidéo s’obscurcit. 

2. Réglez la durée de maintien de l'alarme et les options de déclenchement de l'alarme. Les étapes de 

configuration sont les mêmes que celles pour la détection de mouvement. Veuillez consulter le chapitre 

sur la détection de mouvement pour plus de détails. 

3. Cliquez sur le bouton « Save » (Enregistrer) pour sauvegarder les paramètres. 

4. Réglez la sensibilité de la détection des exceptions. Cliquez sur l'onglet « Sensitivity » (Sensibilité) 

pour accéder à l'interface comme illustré ci-dessous. 
 

 

 

Faites glisser le curseur pour régler la valeur de la sensibilité ou entrez directement la valeur de la 

sensibilité dans le champ de saisie de texte. Cliquez sur le bouton « Save » (Enregistrer) pour 

sauvegarder les paramètres. 

 

※ Configuration de la caméra et de la zone environnante 

1. La fonction de mise au point automatique ne doit pas être activée pour la détection des exceptions. 

2. Ne pas activer la détection d'exception lorsque la lumière change beaucoup dans la scène. 
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4.5.3 Franchissement de ligne 

Cette fonction n'est disponible que pour certains modèles.  

Franchissement de ligne : l'alarme se déclenche si la cible franchit les lignes d'alarme prédéfinies.  

Allez à Config→Event (Événement)→interface Line Crossing (Franchissement de ligne) comme 

illustré ci-dessous. 

 

 

 

1. Activez l’alarme de franchissement et réglez la durée de maintien de l'alarme. 

2. Définissez les options de déclenchement de l'alarme. Les étapes de configuration sont les mêmes 

que celles pour la détection de mouvement. 

3. Cliquez sur le bouton « Save » (Enregistrer) pour sauvegarder les réglages. 

4. Définissez la zone et la sensibilité de l'alarme de franchissement de ligne. Cliquez sur l'onglet 

« Area » (Zone) pour accéder à l'interface comme illustré ci-dessous. 
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Définissez le numéro et la direction de la ligne d'alarme. Il est possible d'ajouter jusqu'à 4 lignes. 

Direction: A→B, A→B ou AB. Ceci indique la direction de l'intrus/véhicule qui traverse la ligne 

d'alarme.  

A→B : l'alarme se déclenche lorsque l'intrus/véhicule franchit la ligne d'alarme de B à A ou de A à B. 

A→B : l'alarme se déclenche lorsque l'intrus/véhicule franchit la ligne d'alarme de A à B. 

AB : l'alarme se déclenche lorsque l'intrus/véhicule franchit la ligne d'alarme de B à A. 

Cliquez sur le bouton « Draw Area » (Tracer zone), puis faites glisser la souris pour tracer une ligne 

dans l'image. Cliquez sur le bouton « Stop drawing » (arrêter de tracer) pour arrêter le traçage. Cliquez 

sur le bouton « Clear » (Effacer) pour supprimer les lignes. Cliquez sur le bouton « Save » (Enregistrer) 

pour sauvegarder les paramètres.  

5. Réglez la programmation de l'alarme de franchissement de ligne. Les étapes de configuration de la 

programmation sont les mêmes que celles pour l'enregistrement de la programmation. 

 

※ Configuration de la caméra et de la zone environnante 

1. La fonction de mise au point automatique ne doit pas être activée pour la détection de 

franchissement de ligne. 

2. Évitez les scènes avec beaucoup d'arbres ou celles avec des changements de lumière variés 

(comme beaucoup de phares clignotants). La luminosité de l'environnement des scènes ne doit pas 

être trop faible.  

3. Les caméras doivent être montées à une hauteur de 2,8 mètres ou plus. 

 

4. Maintenez l'angle de montage de la caméra à environ 45°. 

 

5. Les objets détectés ne doivent pas représenter moins de 1 % de l'image entière et les plus 

grandes tailles des objets détectés ne doivent pas représenter plus de 1/8 de l'image entière. 

 

6. Assurez-vous que les caméras puissent voir les objets pendant au moins 2 secondes dans la zone 

détectée pour une détection précise. 

7. Un éclairage adéquat et un contexte éclairé sont essentiels à la détection des franchissements de 

ligne. 

 

4.5.4 Intrusion 

Cette fonction n'est disponible que pour certains modèles. 

Intrusion : les alarmes se déclenchent si la cible entre dans les zones prédéfinies. 

Allez à Config→Event (Événement)→interface Intrusion comme illustré ci-dessous. 
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1. Activez l’alarme de détection d’intrusion de région et réglez la durée de maintien de l'alarme. 

2. Définissez les options de déclenchement de l'alarme. Les étapes de configuration sont les mêmes 

que celles pour la détection de mouvement. 

3. Cliquez sur le bouton « Save » (Enregistrer) pour sauvegarder les réglages. 

4. Définissez la zone d’alarme de la détection d'intrusion. Cliquez sur l'onglet « Area » (Zone) pour 

accéder à l'interface comme illustré ci-dessous. 

 

 

 

Définissez le numéro de la zone d'alarme à droite. Il est possible d'ajouter jusqu'à 4 zones d'alarme. 

Cliquez sur le bouton « Draw Area » (Tracer zone) et ensuite cliquez autour de la zone que vous 

voulez définir comme zone d'alarme dans l'image de gauche (la zone d'alarme doit être une zone 

fermée). Cliquez sur le bouton « Stop drawing » (arrêter de tracer) pour arrêter le traçage. Cliquez sur 

le bouton « Clear » (Effacer) pour supprimer la zone d'alarme. Cliquez sur le bouton « Save » 

(Enregistrer) pour sauvegarder les paramètres.  

5. Définissez la programmation de la détection d'intrusion. Les étapes de configuration de la 

programmation sont les mêmes que celles pour la configuration de l'enregistrement de la 

programmation. 
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※ Configuration de la caméra et de la zone environnante 

1. La fonction de mise au point automatique ne doit pas être activée pour la détection d'intrusion. 

2. Évitez les scènes avec beaucoup d'arbres ou celles avec des changements de lumière variés 

(comme beaucoup de phares clignotants). La luminosité de l'environnement des scènes ne doit pas 

être trop faible.  

3. Les caméras doivent être montées à une hauteur de 2,8 mètres ou plus. 

 

4. Maintenez l'angle de montage de la caméra à environ 45°. 

 

5. Les objets détectés ne doivent pas représenter moins de 1 % de l'image entière et les plus 

grandes tailles des objets détectés ne doivent pas représenter plus de 1/8 de l'image entière. 

 

6. Assurez-vous que les caméras puissent voir les objets pendant au moins 2 secondes dans la zone 

détectée pour une détection précise. 

7. Une lumière adéquate et un contexte éclairé sont essentiels pour la détection des intrusions. 

 

4.5.5 Détection de densité de la foule 

Cette fonction peut détecter la densité des personnes dans une zone spécifiée. 

Allez à Config→Event (Événement)→Crowd Density (Densité de la foule), comme illustré ci-dessous. 
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1.  Activez la détection de la densité de la foule. 

2.  Définissez « Refresh Frequency » (Fréquence de rafraîchissement), « Density Alarm Threshold » 

(Seuil d’alarme de densité) et « Alarm Holding Time » (Durée de maintien de l'alarme). 

Refresh Frequency (Fréquence de rafraîchissement) : fréquence de rafraîchissement du résultat de 

détection. 

Density Alarm Threshold (Seuil d’alarme de densité) : l’alarme se déclenchera lorsque le pourcentage 

de densité de la foule dans la zone spécifiée dépassera la valeur de seuil prédéfini. 

3. Définissez les options de déclenchement de l'alarme. Les étapes de configuration sont les mêmes que 

celles pour la détection de mouvement. 

4. Définissez la zone d’alarme de la détection de densité de la foule. Cliquez sur l'onglet « Area » (Zone) 

comme illustré ci-dessous. 

Cliquez sur « Draw area » (Tracer zone), puis faites glisser la souris pour tracer une zone rectangulaire. 

Faites glisser les lignes de bordure du rectangle pour modifier la taille et déplacer le rectangle pour 

modifier sa position. Cliquez sur « Stop Draw » (Arrêter de tracer) pour arrêter de tracer la zone. Cliquez 

sur « Clear » (Effacer) pour effacer la zone. 

 

 

5. Définissez la programmation de la détection de densité de la foule. Les étapes de configuration de la 

programmation sont les mêmes que celles pour la configuration de l'enregistrement de la programmation. 

 

※ Configuration de la caméra et de la zone environnante 

1. L’objectif de la caméra doit être face au flux de personnes. Une légère déviation de la direction du flux 

de personnes par rapport à l’axe de l’objectif de la caméra est autorisée ; l’angle (a) doit être inférieur à 

45°. Il est recommandé que l’angle entre l’objectif de la caméra et le sol (b) soit compris entre 30 et 60°. 
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2. La taille d’une seule personne doit occuper de 1 à 5 % de l’image entière et la hauteur d’une seule 

personne peut aller de 1/5 à la moitié de l’image entière. 

3. Cette fonction est inapplicable pour une scène comprenant de nombreux objets en mouvement qui 

ne sont pas des humains (comme des voitures en mouvement). 

4. Des arbres et des panneaux publicitaires en nombre affecteront les résultats de la détection dans la 

zone de détection. 

 

4.5.6 Intrusion de personnes 

Cette fonction est conçue spécialement pour les scènes extérieures. Une alarme sera déclenchée si 

quelqu’un pénètre dans la zone de détection pendant 3 à 5 secondes. Les étapes de configuration 

sont les suivantes. 

1.  Allez à Config→PTZ→People Intrusion (Intrusion de personnes). 

2.  Activez la détection d’intrusion de personnes. 

3.  Définissez « Alarm Sensititivy » (Sensibilité de l’alarme) et « Alarm Holding Time » (Durée de 

maintien de l'alarme). 

4.  Définissez les options de déclenchement de l'alarme. Les étapes de configuration sont les mêmes 

que celles pour la détection de mouvement. 

5.  Définissez la programmation de la détection d'intrusion de personnes. Les étapes de configuration 

de la programmation sont les mêmes que celles pour l'enregistrement de la programmation. 

 

 

 

※ Configuration de la caméra et de la zone environnante 

1.     La zone de détection doit disposer d’un éclairage stable et approprié.  

2.     Pour détecter toutes les personnes se déplaçant dans la zone de détection, la caméra doit être 

installée à une hauteur comprise entre 1 mètre et 3 mètres. 

3.     Pour s’assurer que le caméra puisse capturer tous les objets intérieurs, la lentille de la caméra 

doit être orientée dans la direction à détecter et la caméra doit être installée de préférence dans 

un coin de la salle. 
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4.     L’image capturée des personnes doit occuper entre 1/5 et la moitié de l’image entière. 

5.     De fausses alarmes seront déclenchées si la scène intérieure comporte des lumières 

agglutinées et changeant fréquemment. 

6.     Cette fonction est inapplicable en extérieur. 

 

4.5.7 Comptage de personnes 

Cette fonction sert à calculer le nombre de personnes entrant ou sortant de la zone de détection ; pour 

cela, elle détecte, suit et compte les contours des têtes des personnes. Les étapes de configuration 

sont les suivantes. 

1.  Allez à Config→Event (Événements)→People Counting (Comptage de personnes). 

2.  Activez la détection de comptage de personnes. 

3.  Définissez les options « Detection Sensitivity » (Sensibilité de détection), « Entrancing Threshold » 

(Seuil d’entrée), « Departing Threshold » (Seuil de sortie), « Staying Threshold » (Seuil de séjour), 

« Counting Period » (Période de comptage), « Alarm Holding Time » (Temps de maintien d’alarme), 

etc. 

Counting Period (Périodes de comptage) : toutes, quotidienne, hebdomadaire ou mensuelle. 

Counting Reset (Réinitialisation du comptage) : le fait de cliquer sur le bouton « Reset » (Réinitialiser) 

effacera le nombre de personnes comptées et redémarrera la période de comptage. 

Si le nombre de personnes dépasse la valeur seuil prédéfinie (la valeur par défaut est 500, la valeur 

maximale est 655350), une alarme se déclenchera.  

Lorsque quelqu’un franchit la zone détectée, cela prend de 1 à 5 secondes pour achever la détection 

du comptage de personnes selon les différentes scènes. 

4.  Définissez les options de déclenchement de l'alarme. Les étapes de configuration sont les mêmes 

que celles pour la détection de mouvement. 
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5.  Définissez la zone de comptage des personnes. Cliquez sur l'onglet « Area » (Zone) pour accéder à 

l'interface de définition. 

 

 



 

50 

 

Cliquez sur « Draw area » (Tracer zone), puis faites glisser la souris pour tracer une zone rectangulaire. 

Faites glisser les quatre ligne de bordure ou les quatre coins du rectangle pour en modifier la taille. 

Cliquez sur « Stop Draw » (Arrêter de tracer) pour arrêter de tracer la zone. Cliquez sur « Clear » 

(Effacer) pour effacer la zone. Cliquez sur la flèche ou sur l’autre extrémité de la flèche et faites-la 

glisser pour changer le sens d’entrée des personnes.  

L’image capturée des personnes doit occuper (en largeur ou en hauteur) entre 1/5 et la moitié de la 

zone de détection tracée. Le sens de la flèche rouge indique l’entrée. 

Une fois le sens de comptage des personnes défini, retournez à l’interface d’affichage Live pour 

afficher les résultats du comptage. Veuillez vous référer à l'illustration suivante. 

 

※ Configuration de la caméra et de la zone environnante 

1. Les caméras doivent être installées dans la zone avec des sources de lumière stables et adéquates. 

2. La couleur de fond (la couleur du sol) doit être une couleur claire. 

3. L’objectif de la caméra doit être réglé droit vers le bas pour s’assurer que la tête entière des 

personnes puissent être capturée.  

4. La hauteur d’installation de la caméra dépend de la longueur focale de l’objectif. L’entrée/la sortie de 

l’image doit occuper plus de la moitié de la largeur de l’image entière et la tête d’une seule personne 

doit occuper environ 1/5 de la hauteur de l’image entière. Pensez à conserver suffisamment d’espace 

des deux côtés pour laisser l’entrée/la sortie au centre de l’image entière. 

La hauteur recommandée de l’installation est indiquée ci-dessous : 

  

Objectif Hauteur de montage 

2,8 mm 2,6 - 3,2 m 

3,3 mm 3,0 - 4,0 m 

3,6 mm 3,3 - 5,0 m 

 

5. Des éclairages divers et changeant perturberont le comptage des personnes et les scènes sombres 

réduiront la précision du comptage. 

6. Si quelqu’un se déplace à grande vitesse (franchissant la zone détectée en moins de 2 secondes), 

cela peut avoir pour conséquence un échec de la détection. Toutefois, si quelqu’un se déplace à petite 

vitesse, restant plus de 15 secondes dans la zone détectée, la caméra cessera la poursuite. 

7. Si des personnes portent des vêtements de même couleur que la couleur de fond, cela peut 

provoquer un échec de la détection. 

8. Un couvre-chef susceptible de masquer les caractéristiques de la tête entraînera un échec de la 

détection. 

 

4.6  Configuration du réseau 

4.6.1 TCP/IPv4 

Allez à Config→Network (Réseau)→interface TCP/IP comme illustré ci-dessous. 
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Utilisez l'adresse IP (IPv4 par exemple). Il y a deux options pour la configuration IP : « Obtain an IP 

address automatically » (Obtenir une adresse IP automatiquement )(par DHCP) et « Use the following 

IP address » (Utiliser l'adresse IP suivante »).  

Test : testez l'efficacité de l'adresse IP en cliquant sur le bouton. 

Utiliser PPPoE. Cliquez sur l'onglet « PPPoE Config » (Config PPPoE) pour aller à l'interface comme 

illustré ci-dessous. Activez PPPoE et entrez ensuite le nom d'utilisateur et le mot de passe de votre 

ISP.  
 

 

 

Les deux méthodes de connexion au réseau peuvent être utilisées. Si PPPoE est utilisé pour se 

connecter à Internet, la caméra obtient une adresse IP WAN dynamique. Cette adresse IP change 

fréquemment. Pour être notifié, la fonction de notification de changement d'IP peut être utilisée.  

Cliquez sur « IP Change Notification Config » (Config notification changement IP) pour accéder à 

l’interface comme illustré ci-dessous. 

 

 
 

Trigger Email (Déclencher e-mail) : lorsque l'adresse IP de l’appareil change, la nouvelle adresse IP 

est envoyée à l'adresse e-mail ayant été configurée. 

Trigger FTP (Déclencher FTP) : lorsque l'adresse IP de l'appareil change, la nouvelle adresse IP est 

envoyée au serveur FTP ayant été configuré. 
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4.6.2 Port 

Allez à Config→Network (Réseau)→Port interface (Interface des ports) comme illustré ci-dessous. 

HTTP port (port http), Data port (port données) et RTSP port (port RTSP) peuvent être définis. 

 

 
 

HTTP Port (port HTTP) : 80 par défaut. 

HTTPS Port (port HTTP) : 443 par défaut. 

Data Port (port données) : 9008 par défaut. 

RTSP Port (port RTSP) : 554 par défaut. 

 

4.6.3 Serveur 

Cette fonction est utilisée pour connecter le Comelit Advance VMS.  

 

 

 

1. Cochez « Enable » (Activer). 

2. Vérifiez l'adresse IP et le port du serveur de transfert média dans le Comelit Advance VMS. Activez 

ensuite le rapport automatique dans le Comelit Advance VMS lors de l'ajout d'un nouvel appareil. 

Ensuite, entrez les autres informations de l'appareil dans le Comelit Advance VMS. Le système 

attribue ensuite automatiquement un ID à l’appareil. Veuillez le vérifier dans le Comelit Advance VMS.                         

3. Entrez l'adresse du serveur, le port du serveur et l'ID de l’appareil dans les cases correspondantes. 

Cliquez sur le bouton « Save » (Enregistrer) pour sauvegarder les paramètres. 

 

4.6.4 DDNS 

Si la caméra est configurée avec une connexion DHCP, le DDNS doit être configuré. 

1. Allez à Config→Network (Réseau)→ DDNS. 
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2. Demandez un nom de domaine. Prenez www.comelitdns.com par exemple.  

Entrez www.comelitdns.com dans la barre d'adresse IE pour visiter son site internet. Choisissez votre 

langue et cliquez ensuite sur le bouton « Register product » (Enregistrer produit). 

 

4.6.5 SNMP 

Cette fonction n'est disponible que pour certains modèles. 

Pour obtenir des informations sur l’état de la caméra, les paramètres et les alarmes et gérer la caméra 

à distance, la fonction SNMP peut être utilisée. Avant d'utiliser la fonction SNMP, installez un outil de 

gestion SNMP et définissez les paramètres du SNMP, tels que le port SNMP, l'adresse trap. 

1. Allez à Config→Network (Réseau)→SNMP. 

 

http://www.comelitdns.com/
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2. Cochez la case de la version correspondante (Enable SNMPv1, Enable SNMPv2, Enable SNMPv3) 

en fonction de la version du logiciel SNMP qui sera utilisée.  

3. Définissez les valeurs pour « Read SNMP Community » (Lire communauté SNMP) , « Write SNMP 

Community » (Écrire communauté SNMP), « Trap Address » (Adresse trap), « Trap Port » (Port trap), 

etc. Assurez-vous que les paramètres sont les mêmes que ceux du logiciel SNMP. 

Remarque : veuillez utiliser une version différente en fonction du niveau de sécurité dont vous avez 

besoin. Plus la version est élevée, plus le niveau de sécurité est élevé. 

 

4.6.6 802.1X 

Si elle est activée, les données de la caméra peuvent être protégées. Lorsque la caméra est 

connectée au réseau protégé par l'IEE802.1x, une authentification utilisateur est nécessaire. 
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Pour utiliser cette fonction, la caméra doit être connectée à un commutateur prenant en charge le 

protocole 802.1x. Le commutateur peut être considéré comme un système d'authentification identifiant 

l’appareil dans un réseau local. Si la caméra connectée à l'interface réseau du commutateur a réussi 

l'authentification du commutateur, il est possible d'y accéder via le réseau local.  

Type de protocole et version EAPOL : utilisez les paramètres par défaut. 

Nom d'utilisateur et mot de passe : le nom d'utilisateur et le mot de passe doivent être les mêmes que 

le nom d'utilisateur et le mot de passe demandés et enregistrés dans le serveur d'authentification. 

 

4.6.7 RTSP 

Allez à Config→Network (Réseau)→RTSP. 
 

 
 

Sélectionnez « Enable » (Activer) pour activer la fonction RTSP. 

Port : port d'accès du média de diffusion en continu (par défaut, 554). 

Address (Adresse) : le format d'adresse RTSP (unidiffusion) qui peut être utilisé pour lire le flux dans 

un lecteur multimédia. 

Adresse multidiffusion 

Main stream (Flux principal) : le format d’adresse est 

 rtsp://IP address: rtsp port/profile1?transportmode=mcast 

Sub stream (Sous-flux) : le format d'adresse est 

 rtsp://IP address: rtsp port/profile2?transportmode=mcast 

Third stream (Troisième flux) : le format d'adresse est 

 rtsp://IP address: rtsp port/profile3?transportmode=mcast 
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Audio: en entrant l'adresse du flux principal/sous-flux dans le lecteur VLC, la vidéo et l'audio seront 

lues automatiquement. 

Si l’option « Allow anonymous login… » (Autoriser connexion anonyme...) est cochée, il n'est pas 

nécessaire d'entrer le nom d'utilisateur et le mot de passe pour voir la vidéo. 

Si « auto start » (démarrage automatique) est activé, les données multidiffusion reçues doivent être 

ajoutées dans un lecteur VLC pour lire la vidéo. 

 

Remarque :  1. Cette caméra supporte la lecture locale via un lecteur VLC. Entrez l'adresse RTSP 

(unidiffusion ou multidiffusion, par ex. 

rtsp://192.168.226.201:554/profile1?transportmode=mcast) dans le lecteur VLC pour 

la lecture simultanée avec le client internet. 

2. L'adresse IP mentionnée ci-dessus ne peut pas être IPv6. 

3. Évitez d'utiliser la même adresse multidiffusion dans le même réseau local. 

4. Lors de la lecture de la vidéo via les flux multidiffusion dans un lecteur VLC, faites 

attention au mode du lecteur VLC. S'il est réglé sur le mode TCP, la vidéo ne peut pas 

être lue. 

5. Si le format de codage de la vidéo du flux principal est MJPEG, la vidéo peut être 

désordonnée à certaines résolutions. 

 

4.6.8 UPnP 

Si cette fonction est activée, il est possible d'accéder rapidement à la caméra via le LAN. 

Allez à Config→Network (Réseau)→UPnP. Activez UPN et saisissez ensuite le nom UPnP. 

 

 

 

4.6.9 E-mail 

Si vous avez besoin de déclencher E-mail lorsqu'une alarme se produit ou que l'adresse IP est 

modifiée, définissez d'abord l'E-mail ici.  

Allez à Config→Network (Réseau) →Email. 
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Sender Address (Adresse de l’expéditeur) : adresse e-mail de l'expéditeur. 

Username and Password (Nom d’utilisateur et mot de passe) : nom d’utilisateur et mot de passe 

de l'expéditeur. 

Server Address : Adresse IP SMTP ou nom d'hôte. 

Sélectionnez le type de connexion sécurisée dans la liste déroulante « Secure Connection » 

(Connexion sécurisée) en fonction de ce qui est requis. 

SMTP Port : port SMTP. 

Send Interval(S) : intervalle de temps d'envoi d'un e-mail. Par exemple, s’il est réglé sur 60 secondes 

et que plusieurs alarmes de détection de mouvement sont déclenchées en l'espace de 60 secondes, 

elles seront considérées comme un seul événement d'alarme et un seul e-mail sera envoyé. Si un 

événement d'alarme de mouvement est déclenché, puis un autre événement d'alarme de détection de 

mouvement est déclenché après 60 secondes, deux e-mails seront envoyés. Lorsque différentes 

alarmes sont déclenchées en même temps, plusieurs e-mails sont envoyés séparément. 

Cliquez sur le bouton « Test » pour tester la connexion du compte. 

Recipient Address : adresse e-mail du destinataire. 

 

4.6.10  FTP 

Après la configuration d'un serveur FTP, les images capturées lors d'événements sont téléchargées 

vers le serveur FTP. 

Allez à Config→Network (Réseau) →FTP. 
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Server Name : nom du serveur FTP. 

Server Address : adresse IP ou nom de domaine du serveur FTP. 

Upload Path : répertoire où les fichiers seront téléchargés. 

Port : port du serveur FTP. 

Use Name and Password : nom d'utilisateur et mot de passe qui sont utilisés pour se connecter au 

serveur FTP. 

 

4.6.11  HTTPS 

HTTPS assure l'authentification du site Web et protège la confidentialité des utilisateurs. 

Allez à Config→Network (Réseau)→HTTPS comme illustré ci-dessous. 

 

 

 

Il y a un certificat installé par défaut comme illustré ci-dessus. Activez cette fonction et enregistrez-la. Il 

est ensuite possible d‘accéder à la caméra en entrant https://IP address:https port via le navigateur 

internet (par ex. https://192.168.1.150:443). 

Un certificat privé peut être créé si les utilisateurs ne veulent pas utiliser celui par défaut. Cliquez sur 

« Delete » (Supprimer) pour effacer le certificat par défaut. Ensuite, l'interface suivante s’affiche. 

https://ip/
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* S'il existe un certificat signé, cliquez sur « Browse » (Parcourir) pour le sélectionner, puis cliquez sur 

« Install » (Installer) pour l'installer. 

* Cliquez sur « Create a private certificate » (Créer un certificat privé) pour entrer dans l'interface de 

création suivante. 

 

 

 

Cliquez sur le bouton « Create » (Créer) pour créer un certificat privé. Entrez le pays (seulement deux 

lettres disponibles), le domaine (adresse IP de la caméra/domaine), la date de validité, le mot de passe, 

la province/état, la région, etc. Cliquez ensuite sur « OK » pour enregistrer les paramètres. 

* Cliquez sur « Create a certificate request » (Créer une demande de certificat) pour entrer dans 

l'interface suivante. 

 

 

 

Cliquez sur « Create » (Créer) pour créer la demande de certificat. Téléchargez ensuite la demande de 

certificat et soumettez-la à l'autorité de certification de confiance pour signature. Après avoir reçu le 

certificat signé, importez-le dans l'appareil. 

 

4.6.12  P2P (option) 

Si cette fonction est activée, il est possible d'accéder rapidement à la caméra réseau en ajoutant l'ID de 

l'appareil dans le client de surveillance mobile ou le client Comelit Advance VMS via WAN. Activez 

cette fonction en allant à Config→Network (Réseau)→P2P interface. 
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. 

 

4.6.13  QoS 

La fonction QoS (Quality of Service) est utilisée pour fournir une qualité de service différente pour 

différentes applications de réseau. En cas de bande passante insuffisante, le routeur ou le 

commutateur trie les flux de données et les transfère en fonction de leur priorité pour résoudre le retard 

du réseau et la congestion du réseau en utilisant cette fonction. 

Allez à Config→Network (Réseau)→QoS. 

 

 

 

Vidéo/Audio DSCP : la plage va de 0 à 63. 

Alarme DSCP : la plage va de 0 à 63. 

Manager DSCP: la plage va de 0 à 63. 

Plus le chiffre est élevé, plus la priorité est élevée. 

 

 

4.7 Configuration de la sécurité 

4.7.1 Configuration utilisateur 

Allez à Config→Security (Sécurité)→interface Utilisateur comme illustré ci-dessous. 

 

 

 

Ajouter utilisateur : 

1. Cliquez sur le bouton « Add » (Ajouter) pour faire apparaître le champ de saisie de texte suivant. 
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2. Saisissez le nom de l'utilisateur dans le champ de saisie de texte « User Name » (Nom d'utilisateur). 

3. Entrez des lettres ou des chiffres dans le champ de saisie de texte « Password » (Mot de passe) et 

« Confirm Password » (Confirmer mot de passe). 

4. Choisissez le type d'utilisateur. L'administrateur a toutes les autorisations. Un utilisateur normal ne peut voir 

que la vidéo en direct. Un utilisateur avancé a les mêmes autorisations qu'un administrateur, sauf pour la 

gestion des utilisateurs, les paramètres de sauvegarde, la réinitialisation et la mise à niveau du micrologiciel. 

5. Saisissez l'adresse MAC du PC dans le champ de saisie de texte « Bind Mac » (Lier MAC). 

Si cette option est activée, seul le PC avec l'adresse MAC spécifiée peut accéder à la caméra pour cet utilisateur. 

6. Cliquez sur le bouton « OK » et le nouvel utilisateur ajouté s’affiche ensuite dans la liste des utilisateurs. 

 

Modifier utilisateur : 

1. Sélectionnez un utilisateur pour modifier le mot de passe et l'adresse MAC, si nécessaire, dans la 

liste de configuration des utilisateurs. 

2. La fenêtre de dialogue « Edit user » (Modifier utilisateur) apparaît en cliquant sur le bouton « Modify » 

(Modifier). 
 

 

 

3. Saisissez l'ancien mot de passe de l'utilisateur dans le champ de saisie de texte « Old Password » 

(Ancien mot de passe). 

4. Entrez le nouveau mot de passe dans le champ de saisie de texte « New Password » (Nouveau mot 

de passe) et « Confirm Password » (Confirmer mot de passe). 

5. Entrez l'adresse MAC de l'ordinateur, le cas échéant. 

6. Cliquez sur le bouton « OK » pour enregistrer les paramètres. 

Remarque : pour modifier le niveau d'accès d'un utilisateur, celui-ci doit être supprimé et ajouté à 

nouveau avec le nouveau niveau d'accès. 
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Supprimer utilisateur : 

1. Sélectionnez l'utilisateur à supprimer dans la zone de liste de configuration des utilisateurs. 

2. Cliquez sur le bouton « Delete » (Supprimer) pour supprimer l'utilisateur. 

Remarque : le compte administrateur par défaut ne peut pas être supprimé. 

 

4.7.2 Utilisateur en ligne 

Allez à Config→Security (Sécurité)→Online User (Utilisateur en ligne) pour voir l’utilisateur en train de 

regarder la vidéo en ligne. 

 

 

 

Un utilisateur administrateur peut expulser tous les autres utilisateurs (y compris d’autres administrateurs). 

 

4.7.3 Bloquer et autoriser listes 

Allez à Config→Security (Sécurité)→Block and Allow Lists (Bloquer et autoriser listes) comme illustré ci-dessous.  

 

 

 

Les étapes de configuration sont les suivantes : 

Cochez la case « Enable address filtering » (Activer le filtrage des adresses). 

Sélectionnez « Block/Allow the following address » (Bloquer/Autoriser l'adresse suivante), IPv4/IPv6/MAC, 

puis entrez l'adresse IP ou l'adresse MAC dans la fenêtre d'adresse et cliquez sur le bouton Add » (Ajouter).  

 

4.7.4 Gestion de la sécurité 

Allez à Config→Security (Sécurité)→Security Management (Gestion de la sécurité) comme illustré ci-dessous. 

 

 

 

Afin d'empêcher le déverrouillage de mots de passe malveillants, la fonction « locking once illegal 

login » (verrouillage une fois de la connexion illégale) peut être activée. Si cette fonction est activée, 

l'échec de la connexion après six tentatives verrouille l'interface de connexion. La caméra peut être à 

nouveau connectée après une demi-heure ou après le redémarrage de la caméra.  
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Pour certaines versions spécifiées, la connexion anonyme avec un protocole privé peut être activée ici. Si 

cette fonction est activée, entrez http://host:port/Anonymous/1[2/3] (par ex. 

http://192.168.1.150:80/Anonymous/1) via un navigateur internet pour accéder à la caméra. 1 indique le flux 

principal ; 2 indique le flux secondaire ; 3 indique le troisième flux. Seule la vidéo peut être visualisée, aucune 

autre opération ne peut être effectuée. 

 

4.8  Maintenance 

4.8.1 Sauvegarder et restaurer 

Allez à Config→Maintenance→Backup & Restore (Sauvegarde et restauration). 

 

 

 

⚫ Paramètres d'importation et d'exportation 

Les paramètres de configuration de la caméra peuvent être exportés d'une caméra à une autre 

caméra. 

1. Cliquez sur « Browse » (Parcourir) pour sélectionner le chemin de sauvegarde des informations 

d'importation ou d'exportation sur PC. 

2. Cliquez sur le bouton « Import Setting » (Paramètres d’importation) ou « Export Setting » 

(Paramètres d'exportation).  

 

⚫ Paramètres par défaut 

Cliquez sur le bouton « Load Default » (Charger par défaut) pour rétablir tous les paramètres du 

système aux paramètres d'usine par défaut, sauf ceux que vous souhaitez conserver. 

                                                 

4.8.2 Redémarrage 

Allez à Config→Maintenance→Reboot (Redémarrer). 

http://host:port/Anonymous/1%5b2/3
http://192.168.1.150/Anonymous/1
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Cliquez sur le bouton « Reboot » (Redémarrer) pour redémarrer l'appareil. 

Réglage du redémarrage temporisé 

Si nécessaire, la caméra peut être configurée pour redémarrer par intervalles de temps. Activez « Time 

Settings » (Paramètres de temps), réglez la date et l'heure, puis cliquez sur le bouton « Save » 

(Enregistrer) pour enregistrer les paramètres. 

 

4.8.3 Mise à niveau 

Allez à Config→Maintenance→Upgrade (Mise à niveau). Dans cette interface, le micrologiciel de la 

caméra peut être mis à jour. 

 

 

 

1. Cliquez sur le bouton « Browse » (Parcourir) pour sélectionner le chemin du fichier de mise à niveau 

2. Cliquez sur le bouton « Upgrade » (Mettre à niveau) pour lancer la mise à jour du micrologiciel. 

3. L'appareil redémarre automatiquement 

Attention ! Ne fermez pas le navigateur et ne déconnectez pas la caméra du réseau pendant la mise 

à niveau. 

 

Pour certains modèles spécifiés, une mise à niveau en ligne est disponible. Les étapes de réglage sont 

les suivantes. 

1.  Créez l'emplacement du fichier de mise à niveau et enregistrez-le. 

2.  Vérifiez la dernière version en cliquant sur « Check version » (Vérifier version). 

3.   Cliquez sur « Upgrade » (Mettre à niveau) pour mettre à niveau le micrologiciel en ligne. 

 

4.8.4 Log 

Pour interroger et exporter le journal : 

1. Allez à Config→Maintenance→Operation Log (Journal opérations). 

 

 

 

2. Sélectionnez le type principal, le sous-type, l'heure de début et de fin. 

3. Cliquez sur « Search » (Rechercher) pour afficher le journal des opérations. 

4. Cliquez sur « Export » (Exporter) pour exporter le journal des opérations.
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5  Playback (lecture) 

5.1 Recherche d’image 
 

Cliquez sur « Search » (Rechercher) pour aller à l’interface comme illustré ci-dessous. Les images 

enregistrées sur carte micro-SD peuvent être trouvées ici. 
 

 
 

⚫  Recherche locale d'images 

1. Choisissez « Picture »— « Local » (Image—Local). 

2. Régler l'heure : sélectionnez la date et choisissez l'heure de début et de fin. 

3. Cliquez sur  pour rechercher les images. 

4. Double-cliquez sur le nom du fichier dans la liste pour afficher les instantanés comme illustré 

ci-dessus. 
 

 

Cliquez sur  pour revenir à l’interface précédente. 

 

⚫  Recherche d'images sur carte Micro-SD 

1. Choisissez « Picture »—« SD Card » (Image—Carte SD). 
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2. Régler l'heure : sélectionnez la date et choisissez l'heure de début et de fin. 

3. Choisissez les événements d'alarme en bas de l'interface. 

4. Cliquez sur  pour rechercher les images. 

5. Double-cliquez sur le nom du fichier dans la liste pour afficher les instantanés. 

Cliquez sur  pour revenir à l’interface précédente. 

 

Les descriptions des boutons se présentent comme suit : 

Icône Description Icône Description 

 

Fermer : sélectionnez une image 
et cliquez sur ce bouton pour 
fermer l'image.   

Fermer tout : cliquez sur ce bouton pour 
fermer toutes les images. 

 

Enregistrer : cliquez sur ce bouton 
pour sélectionner le chemin et 
enregistrer l'image sur PC.  

Enregistrer tout : cliquez sur ce bouton 
pour sélectionner le chemin afin 
d'enregistrer toutes les images sur le PC. 

 

Ajuster taille : cliquez pour ajuster 
l'image à l'écran.  

Taille normale : cliquez sur ce bouton pour 
afficher la taille normale de l'image. 

 

Zoom avant : cliquez sur ce 
bouton pour effectuer un zoom 
avant numérique.  

Zoom arrière : cliquez sur ce bouton pour 
effectuer un zoom arrière numérique. 

 

Lecture du diaporama : cliquez sur 
ce bouton pour démarrer le mode 
diaporama.  

Stop : cliquez sur ce bouton pour arrêter le 
diaporama.  

 
Vitesse de lecture : permet de régler la vitesse de lecture du diaporama. 
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5.2 Recherche vidéo 

5.2.1 Recherche vidéo locale 

Cliquez sur Search (Rechercher) pour aller à l’interface comme illustré ci-dessous. Les vidéos 

enregistrées localement sur PC peuvent être lues dans cette interface. 

 

 

 

1. Choisissez « Record »—« Local » (Enregistrement—Local). 

2. Définissez l'heure de recherche : sélectionnez la date et choisissez l'heure de début et de 

fin. 

3. Cliquez sur  pour rechercher les images. 

4. Double-cliquez sur le nom du fichier dans la liste pour lancer la lecture. 
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Icône Description Icône Description 

 

Bouton de lecture. Après avoir 
mis la vidéo en pause, cliquez 
sur ce bouton pour poursuivre 
la lecture. 

 
Bouton Pause 

 
Bouton Arrêt  

 
Réduire la vitesse  

 
Accélérer 

 
Affichage du filigrane 

 

Activer / désactiver l'audio ; faites glisser le curseur pour ajuster le volume 
après avoir activé l'audio. 

 

 

5.2.2 Recherche vidéo sur carte Micro-SD 

Cliquez sur Search (Rechercher) pour aller à l’interface comme illustré ci-dessous. Les vidéos ayant 

été enregistrées sur carte micro-SD peuvent être lues dans cette interface. 

1. Choisissez « Record »—« SD Card » (Enregistrer—Carte SD). 

2. Définissez l'heure de recherche : sélectionnez la date et choisissez l'heure de début et de fin. 

3. Cliquez sur  pour rechercher les images. 

 

 

 

 

4. Sélectionnez les événements d'alarme au bas de l'interface. 

5. Sélectionnez le flux de mélange (flux vidéo et audio) ou le flux vidéo selon les besoins. 

6. Double-cliquez sur le nom du fichier dans la liste pour lancer la lecture. 
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L'horaire peut être affiché au format 24h/12h/2h/1h en cliquant sur les boutons correspondants. 

Opérations de clip vidéo et de téléchargement : 

1. Recherchez les fichiers vidéo en suivant les étapes ci-dessus. 

2. Sélectionnez l'heure de départ en cliquant sur l'horaire. 

3. Cliquez sur  pour régler l'heure de démarrage, puis ce bouton devient vert (  ). 

4. Sélectionnez l'heure de fin en cliquant sur l’horaire. Cliquez ensuite sur  pour régler l'heure 

de fin. 

5. Cliquez sur  pour télécharger le fichier vidéo dans le PC. 

 

 

 

Cliquez sur « Set up » (Configurer) pour définir le répertoire de stockage des fichiers vidéo.  

Cliquez sur « Open » (Ouvrir) pour lire la vidéo. 

Cliquez sur « Clear List » (Effacer liste) pour effacer la liste des téléchargements. 

Cliquez sur « Close » pour fermer la fenêtre de téléchargement. 
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Annexe 

 

 

Annexe 1 - Dépannage 

 

Mot de passe oublié  

A: Réinitialisation de l'appareil aux réglages d'usine par défaut. 

IP par défaut : 192.168.1.150; Username: admin; Password: admin (Nom d’utilisateur: admin ; Mot de 

passe : admin) 

 

Échec de la connexion des appareils via le navigateur Internet Explorer. 

A: Le réseau n'est pas bien connecté. Vérifier la connexion. 

B: L'adresse IP n'est pas disponible. Changer d'adresse IP. 

C: Le numéro de port Web a été modifié : contacter l'administrateur pour obtenir le bon numéro de port. 

D: Exclure les raisons ci-dessus. Rétablir les paramètres par défaut de Comelit Advance IP Tool. 

 

Comelit Advance IP tool ne peut pas rechercher les appareils. 

Le logiciel anti-virus de votre ordinateur peut en être la cause. Arrêtez-le et tentez de rechercher de 

nouveau l'appareil.  

 

Internet Explorer ne peut pas télécharger le contrôle ActiveX.  

A. Le navigateur Internet Explorer peut être configuré pour bloquer ActiveX. Suivez les étapes 

ci-dessous. 

① Ouvrez le navigateur, puis cliquez sur Outils → Options Internet. 

 

 

 

② Sélectionnez Security (Sécurité) → Custom Level…. (Niveau personnalisé) 

③ Activez toutes les options sous « ActiveX controls and plug-ins » (Contrôles ActiveX et plug-ins).  

④ Cliquez sur OK pour terminer l'installation. 

 

B. Autres plug-ins ou anti-virus bloque ActiveX. Désinstallez-les ou fermez-les. 
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Aucun son ne peut être entendu. 

A: Le dispositif d'entrée audio n'est pas connecté. Connectez-vous et retentez. 

B: La fonction audio n'est pas activée sur le canal correspondant. Activez cette fonction. 

 

Le dispositif est incapable de démarrer normalement lors d’une mise à jour 

Si le dispositif est dans l’incapacité de démarrer normalement lors d’une mise mise à jour, veuillez 

renommer le fichier portant le suffixe .tar updatepack.tar et copiez-le dans le répertoire racine de la 

carte SD. Redémarrez le dispositif et celui-ci se mettra automatiquement à jour à partir de la carte SD. 

Une fois la mise à jour terminée, l’utilisateur pourra rechercher l’adresse IP d’IP Cam dans l’utilitaire IP 

Tool. 
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Annexe 2 - Description des présélections 

 

Appeler 

présélections 

90 Exécuter axe 1 

91 Exécuter tour 1 

92 Exécuter tour 2 

93 Exécuter tour 3 

94 Exécuter tour 4 

95 Menu Rappeler OSD 

97 Activer balayage aléatoire 

99 Activer balayage point par point 

  

  

Définir 

pré-réglage 

91 Définir balayage aléatoire 

92 Définir bordure gauche de balayage point par point 

93 Définir bordure droite de balayage point par point 

94 (trois fois) 
Définir la valeur de la lumière infrarouge proche et 

médiane 

95 (trois fois) 
Définir la valeur de la lumière infrarouge médiane et 

lointaine 

 

 

 

 

 

 

 

 


